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Lesson summary
Phytoplankton constitutes the base of the trophic web in freshwater environments and their
biomass is coupled to all upper trophic levels. Phytoplankton biomass is sensitive to
environmental change, with shifts in the seasonality of blooms, known as phenology, in
response to temperature, nutrients and other environmental changes. Since phytoplankton
phenology in terms of onset, peak and end or variable growth rates for has to be captured at
the high frequency, satellite remote sensing is a suitable technology. This lesson covers how
satellite data allow phytoplankton phenology investigations for Lake Constance, a large deep
clear lake between Germany, Switzerland and Austria.

GLaSS training material outline
This lesson is part of the GLaSS training material. The complete training material outline is
listed on http://data.waterinsight.nl/GLaSS/trainingmaterials/GLaSS_lesson_outline.pdf.
Note that the lessons logically follow up on each other, the later lessons might require skills
that can be acquired during the earlier lessons.
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List of abbreviations
Abbreviation Description
Chl

Chlorophyll

CHM

chlorophyll maximum concentration

CRS

Coordinate Reference System

EO

Earth observation

MERIS

Medium Resolution Imaging Spectrometer

MODIS

Moderate-resolution Imaging Spectroradiometer

MIP

Modular Inversion and Processing System

ROI

Region Of Interest

TSM

Total Suspended Matter
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1 Introduction
Deep clear lakes are essential strategic resources providing multiple ecosystem services and
are resources for recreation and tourism. Therefore they are typically affected by humans,
leading to (often undesirable) environmental changes; moreover lake ecosystems, and
especially freshwater phytoplankton, are sensitive sentinels of environmental and climate
changes. In particular, the seasonality of phytoplankton biomass, known as phenology, has
been demonstrated to shift in response to temperature, nutrient and other environmental
changes.
Over the past decade, latest generation of ocean colour sensors such as MODIS and MERIS
have provided unique information for lake monitoring. In particular, those sensors allow the
phytoplankton biomass to be accurately monitored at the typical high frequency required for
assessing phytoplankton phenology (Palmer et al., 2015).
This lesson relies on the 12-years long MERIS time series and aims to describe the timing
(phenology) and the magnitude of phytoplankton biomass in Lake Constance, a deep clear
lake between Germany, Switzerland and Austria. Although the improvement for large water
treatment and restoration activities, pressures caused by high population density, climate
change and the various utilizations of the lake resources (more than 4.5 million people in all
the three countries depend on Lake Constance for drinking water) threaten the recent
positive ecological developments.
In this lesson, the phytoplankton phenology in Lake Constance is obtained from statistical
analysis of chlorophyll (Chl) concentration, used as proxy of phytoplankton biomass,
obtained from MERIS data from 2003 to 2011. For each year or season, the onset as well as
the frequency of occurrences of phytoplankton is computed for both the whole lake area and
for few sub-basins. A variety of tools available in VISAT-BEAM are used for such purposes.

4 of 14

Global Lakes Sentinel Services (313256)

2 This lesson
2.1 Research question
Does the offset of phytoplankton blooms in Lake Constance change?

2.2 Training objectives / skills to gain in this lesson
The aim of this lesson is to investigate the phenology response of Lake Constance in terms
of onset of phytoplankton bloom and spatial distribution.
•

Visualisation of MERIS-derived products

•

Investigation of phytoplankton abundance (in terms of Chl concentration) during the
year in different sub-basins

•

Definition of regions of interest (ROIs) on image data based on different tools

•

Finding the timing of phytoplankton growth onset basic on statistics applied to timeseries Chl data

2.3 Required software and data
Software and tools
To complete this lesson tasks, the following tools and software are required or suggested:
•

BEAM/SNAP 2.0 (required, see Lesson #1).
Figures and buttons position in this document are referred to the BEAM-VISAT
interface. Some slight difference may occur in SNAP interface.

•

R (see https://www.r-project.org/ for free downloading and details) incl. xts, date and
chron packages (Ryan and Ulrich, 2014; Therneau et al., 2014; James and Hornik,
2015) are suggested to perform the analysis of phenology pattern (in Part 3) through
the scripts provided, but the analysis can be performed through a spreadsheet.
Packages can be installed following instructions in provided scripts.

Downloadable files
• GLaSS_Training_Lesson5.pdf
The main document of the lesson including exercises and questions.
•

GLaSS_Training_Lesson5_Answers.pdf
A document containing answers to all questions proposed in the exercises.

•

GLaSS_Training_Lesson5_DataAndTools.zip
Supplied data and tools, described below.

The zip-file with supplied data and tools contain:
A ‘Sample_data’ directory containing:
•

55 MIP maps of chlorophyll concentration of Lake Constance from available dates in
2005 (GeoTIFF format).

•

‘Constance.shp’ and its complementary files: a shapefile containing two sample
regions selected for data extraction and for the evaluation in phenology changing.
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•

‘Constance_timeSeries.txt’: CHM statistics extracted from all available images from
the same two regions contained in ‘Constance.shp’.

A ‘Tools’ directory containing:
•

‘Stats_extraction_PixEx.xml’ for the extraction of pixels value from MERIS Constance
products through BEAM PixEx operator used in batch mode.

•

‘phenology_Constance.R’, R script for the analysis of phenology in Lake Constance.
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3 Exercise
Part 1 Long-time series generation from EO (Earth Observation) products
through PixEx BEAM operator used in batch-mode
In the GLaSS project core, for the estimation of chlorophyll concentration in Lake Constance,
MIP (Modular Inversion and Processing System) algorithm was used. Its algorithms are
based on physical inversion schemes that derive bio-physical parameters from the measured
radiance signal at the sensor (Heege et al., 2003) through the minimization of the difference
between satellite measured and modelled spectra of water surface. It provides estimates of
chlorophyll maximum concentration (CHM), water turbidity (linearly linked to TSM
concentration at low to moderate concentrations as found in Lake Constance) and Secchi
Disk values. GeoTIFF images provided contain a single band (called ‘band_1’), representing
CHM [mg/m3].
Activities
The first step consists in the CHM values extraction from all available images in 2005, as a
sample year, to analyse CHM trend during the year. PixEx operator extracts alternatively, the
value recorded in a pixel or in a group of pixels, giving all values (with ‘no aggregation’
method), the mean, the minimum, the maximum or the median value of pixels in a square
window of a given size centred in a point of given coordinates. It extracts statistics from all
available products given in input.
 In the folder ‘Tools’ open the ‘Stats_extraction_PixEx.xml’ file.
•

Complete the path for the directory in which MERIS images are stored and the
file pattern (the pattern of all the products you want to include in your
analysis), in this case
‘<sourceProductPaths>...\Sample_data\*.tif</sourceProductPaths> ‘: PixEx
will recursively look for all GeoTIFF products in the folder.

•

Complete the path of the file containing Lake Constance regions centre
coordinates
(‘<coordinatesFile>...\Sample_data\Constance_coord.txt</coordinatesFile>’,
coordinates should be expressed in WGS84 CRS) and the size of the window
for statistics extraction: with ‘<windowSize>3</windowSize>’ a three by three
pixels window is defined.

•

Define the output path (a directory where you want to store PixEx results) and
the prefix you prefer for the name of results file.

•

An expression can be used to define valid pixels: ‘<expression>(band_1 &gt;
0)</expression’. It means that the tool will skip pixels where CHM is less than
zero (where CHM is not calculated, for example on the land, pixels value is
equal to -9999.0 in the GeoTIFF products provided).

•

Define the aggregation method choosing among ‘no aggregation’, ‘min’, ‘max’,
‘mean’, ‘median’.

 Open BEAM Command Line (look for it in your browser typing ‘cmd’) and type
‘gpt …\Tools\ Stats_extraction_PixEx.xml’ (complete the directory path, do not use
blank spaces in the path). PixEx starts collecting all available products in the selected
folder.
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 Two files are thus generated in the output directory,
‘Constance_GeoTIFF_measurements.txt’ and ‘Constance_productIdMap.txt’,
containing, respectively, the values extracted from valid pixels for each station defined
in the coordinates file and a list of all products used for statistics extraction.
 In ‘Constance_GeoTIFF_measurements.txt’ also the number of valid pixels used for
the statistics calculation is provided. Delete all results obtained from less than 50% of
valid pixels (i.e. less than 5 pixels), to avoid outliers.
o Analyse results: what’s the trend of CHM during the year? It can be noticed some kind
of seasonality or values are quite constant?
o Can you recognize any CHM peak in the series? When CHM reaches its maximum in
2005? Is CHM similar in both regions? Where and when is it higher?
o Considering CHM mean plus its standard deviation, how many times did CHM exceed
this threshold in 2005?

Part 2 Spatial distribution of phytoplankton bloom
As shown in Figure 1, some phytoplankton blooms occurred, but not always in both regions,
and with different magnitude. In this part, EO products are used to identify lake pixels
affected by algal blooms and to analyse differences in algal blooms distribution.
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Figure 1. CHM trend in 2005, in ‘Coastal’ and ‘Pelagic’ regions.
Activities
 Start VISAT, the BEAM interface (find it in ...\beam-5.0\bin)
 Open the MERIS image of 1/4/2005 (File > Import Raster Data > GeoTIFF and select
image ’CHM_delake_constance_EOMAP_20050401_102538_MERIS_m0300_32bit.tif’). You can
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read the date from the image name.
 Expand the product folder, expand Bands folder and double click on band_1 to open a
grey-scale map of CHM concentration.
 CHM values can be shown clicking on Pixel info tab and moving the pointer across
the map (it shows the value for each pixel pointed).
 Switch to Colour manipulation tab: choose Editor Basic and the colour ramp you
prefer. Change Minimum and Maximum values to be included in the scale range.

Figure 2. CHM map of Lake Constance on April 1st 2005 displayed in VISAT with
Colour Manipulation tab (left side) and regions used for statistics extractions (red
circles).

Figure 3. CHM map of Lake Constance on April 30th 2005 displayed in VISAT with
Colour Manipulation tab (left side) and regions used for statistics extractions (red
circles).
 Import the shapefile containing Constance regions polygons (Import > Vector Data >
ESRI Shapefile and select ‘Constance.shp’): two masks are automatically generated
 Open

and select

to generate a mask for valid pixels only. A new window
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appears, where a logical band math expression can be defined using band or
predefined masks. Select all valid pixels in the maps typing ‘band_1>0’. An automatic
string warns you whether the expression is correct or nor.

Figure 4. VISAT tool for masks definition through logical Band Maths Expression.
 In order to obtain a mask for each region, containing only valid pixels, open

and

select one region and the mask of valid pixels previously created. Then, click on
to intersect the two elements: a new mask will be created. Edit the name typing in
‘Name’ column ‘Pelagic_valid’. Replicate the same actions for the ‘Costal’ region.
 Open Statistics tool
and calculate statistics
(‘Coastal_valid’ and ‘Pelagic_valid’).

using the last two masks generated

o What’s CHM average value in both regions on April 1st 2005?
o Consider the sum of CHM mean and standard deviation calculated on both region in
2005: how much of the lake surface is interested by the phytoplankton bloom on April
1st 2005?
o How much of the surface affected on April 30th 2005?
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Part 3 Phenology analysis
In this last part, phenology is analysed in both lake regions using long-time series generated
from EO products. The date in which cumulative CHM exceeded the 25% of total CHM in
each year is selected as the start date of phenology. This allows analysing differences
between different regions and different years.
Activities
•

Start the R console installed and open ‘phenology_Constance.R’

•

Complete the script defining the path and file name containing Constance CHM
values (for ex. ‘data <- read.table(‘.../Sample_data/ Constance_timeSeries.txt’,
header=TRUE, sep=‘\t’)

•

Start the script: after loading the data, it excludes dates with less than 50% of valid
pixel in the region, and it computes phenology starting date for each year and region.

o In what region phenology started later in 2008?
o In ’Pelagic’ region, when phenology started earlier?
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4 More information and further reading
This lesson is based on the following report:
•

GLaSS Deliverable 5.3, 2015. Global Lakes Sentinel Services, D5.3: Deep clear
lakes with increasing eutrophication. CNR, WI, EOMAP, BG. Available via:
http://www.glass-project.eu/downloads/

The report is suggested for further reading. It contains processed data time series analysis
for several years for Lake Constance, but also for the following deep clear lakes:
•

Lake Garda

•

Lake Maggiore

•

Lake Vättern

•

Lake Michigan

•

Lake Malawi

•

Lake Tanganyika

For more information on GLaSS, and to download all public reports: www.glass-project.eu.
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